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Background
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• User-friendly and highly interactive power 
system analysis and visualization platform.

• Integrates many commonly performed power 
system analysis tasks

• PowerWorld Simulator runs on all Microsoft 
Windows operating systems 2008 R2/7 and 
newer (both server and client versions, 64-bit 
editions only).

PowerWorld Simulator
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• Simulator seamlessly integrates two functions 
once commonly separated in power flow software:
– Graphical power system case editor (one-line diagrams)
– Power Flow package with many related analysis tools:

• Contingency Analysis (including Remedial Action Schemes), 
Time-Step Simulation, Fault Analysis, Sensitivity Analysis, Loss 
Analysis, Optimal Power Flow (OPF/SCOPF), Available Transfer 
Capability (ATC), Steady-State Voltage Stability (PVQV), 
Transient Stability, Geomagnetic Induced Currents (GIC)

• Distributed Computing option for contingency analysis, 
Transient Stability, ATC, PVQV

PowerWorld Simulator
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• Version 1.0 created in May 1994 at the 
University of Illinois Urbana-Champaign by 
Professor Thomas Overbye (Ph.D.)

• Impetus for early versions was to teach power 
system operation to non-technical audiences.

PowerWorld Simulator History
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• PowerWorld Corporation was formed in 1996 
with the goal of further developing and 
commercializing the Simulator tool.

• Simulator version 23:
– Virtually unrecognizable from the early versions of 

the software.
– Has evolved into a powerful power system analysis 

and visualization environment capable of solving 
very large systems.

PowerWorld Simulator History
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• Provide a better understanding of how to use 
PowerWorld Simulator for power system analysis 
and visualization.

• Provide techniques for building good power 
system models and show how these techniques 
can be used to analyze system issues.

• Provide opportunities for hands-on examples, if 
you wish to participate

• Slides marked with red dot are intended for 
reference and may be skipped to stay on schedule

Training Goals
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• Primary Goal: Make you aware of the 
capabilities of Simulator
– We are frequently asked to add features to 

Simulator that are already available.  
– We want you to make the most of our software.

Training Goals
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PowerWorld Simulator Model 
Architecture and GUI
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• PowerWorld Simulator cases can be easily created from existing text-
based power flow cases stored in the following formats:
– PTI RAW version 23 - 35

• Used with public cases
– FERC 715 cases 
– NERC ERAG, WECC, and ERCOT
– Files obtained from ISOs and Market Operators

– GE PSLF text format  (up to EPC version 23)
• Also used with some public cases, especially WECC

– EMS formats (read-only in Simulator)
• Areva hdbexport (csv)
• ABB Spider (dat)
• Siemens (txt)
• OpenNet (txt)

– UCTE Data Exchange (European standard, read-only in Simulator)
– Others: MATPOWER, IEEE Common Format, BPA IPF, PowerSim

Editing and Analyzing an Existing 
Power Flow Case
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• Menus are integrated in the Ribbon interface

Ribbon Interface

File Menu
Quick Access Toolbar

Ribbon Groups

Application Title 
Bar

Help Button

Ribbon Tabs
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• Selecting a menu item from the Ribbon reveals 
a set of task-specific buttons
– Previous Slide shows the Case Information ribbon 

tab
– Change to the Tools ribbon tab

– Interface is simplified by presenting only the 
buttons relevant to the selected menu item.

Ribbon Interface
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• Frequently-used buttons may be added to the 
Quick Access Toolbar, which is always visible

• Right click on button to add, then select “Add 
to Quick Access Toolbar”

Ribbon Interface:
Quick Access Toolbar

Quick Access Toolbar
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• Provides static model of power system
• For some studies this model is sufficient
• For other studies model needs to be augmented

– Generator cost information 
– Reactive capability curve
– PowerWorld Simulator case options
– Interface definitions
– Injection group definitions
– Contingency Definitions
– Etc… and Much more

Power Flow Data
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Analysis Flow Chart
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• Single system model
• Power flow data is subset of system model
• Text-based Case Information Displays are 

always provided
• Oneline diagrams may optionally be created 

and can be used with different cases

Display/Model Relationships



17© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

Display/Model Relationships

Power Flow Data

PowerWorld Simulator Case

One-line
Diagram

One-line
Diagram

Case Information
Displays

PowerWorld User

Busview
One-line
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• Relationship between oneline objects and 
system model is NOT a one-to-one mapping
– multiple oneline objects can be linked to the same 

system model object

• This is a more powerful approach, but 
introduces ambiguity when deleting objects
– delete just the oneline display object
– delete oneline display object and model object

Display/Model Relationships
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• Example: 2,000 
bus synthetic 
Texas case saved 
in PSLF version 21 
format.

• Click the File 
Menu and choose 
Open Case to view 
open dialog

• Choose case 
ACTIVSg2000.epc

Texas Example
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• The graphical power system case editor and 
the power flow package are implemented in 
Simulator’s two distinct modes:
– Edit Mode
– Run Mode 

• Mode is always visible on the left edge of the 
Ribbon

Modes of Operation
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• Stand alone power flow
• Power flow analysis tools and sensitivities 

– Contingency Analysis
– Time-Step Simulation
– Optimal Power Flow (OPF) and Security-Constrained OPF 

(SCOPF)
– PV and QV Curve Tools (PVQV)
– Available Transfer Capability (ATC)
– Sensitivity Analysis
– Loss Analysis
– Fault Analysis
– Transient Stability
– Geomagnetically Induced Current (GIC)

Run Mode
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• Used to create a new case or modify an existing 
case.

• Use the Ribbon buttons to switch between 
modes.

• You can switch to Edit Mode at just about any 
time during a simulation.

• The tools and techniques of Edit Mode will be 
introduced by creating a oneline diagram and 
using it to interact with a case.

Edit Mode
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• Show the Message Log (Tools Ribbon or Quick 
Access Toolbar) to view iterations.

• To perform a single power flow solution, click 
the Solve Power Flow button (Tools Ribbon or 
Quick Access Toolbar).
– mode is automatically switched to Run (if there are 

no validation errors, such as a system slack bus not 
set)

– case should converge within several iterations

Solving the Case
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• Provide text-based view of the case
• Select Case Information ribbon tab  Case 

Description to view an enterable description of the 
case

• Discussed in greater detail in another section

Case Information Displays

PTI (raw) format 
allows 2 lines;
PWB and epc
formats 
allow unlimited
number
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Case Summary Dialog

Select for Help, or 
press F1 key

NOTE: There are no changeable 
fields on this dialog

Summary
of total case
Load, shunts,
and generation

List of slack
Bus(es)
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• Shows complete power flow information for all 
buses with Area/Zone/Owner/DataMaintainer
Filter set to Yes.

• To display use Case Information ribbon tab
Power Flow List.

• Display has its own local menu.  To view, right click 
anywhere on the list.  

Power Flow List
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Power Flow List

Local 
Menu of 
Power 
Flow List
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• Similar to Power Flow List, except list can be used to 
show flow at individual or a set of buses

• To display use Case Information ribbon tab Quick 
Power Flow List.

• Enter number or range of numbers of buses to view
• Double-click to move to desired bus, or right-click for 

information.
• Area/Zone/Owner/DataMaintainer filters are not 

used.

Quick Power Flow List
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Quick Power Flow List

Enter either a 
single bus, a 
set of buses 

separated by 
commas, or a 

range of 
buses

Clears the list

New buses appear at 
the end of the list

Format is similar to 
Power Flow List

Circuit identifier 
99 indicates an 
equivalent line
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• Graphical replacement for Quick Power Flow List
– Easier to use
– Much more powerful approach
– Allows user to navigate through buses like web pages

• To display, use Onelines ribbon tab  Bus View
• Auto-generates oneline diagrams at each bus, one at a 

time, showing all devices connected to bus and all 
flows.

• Operations just like other oneline diagrams in 
Simulator

Bus View
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Bus View Oneline
Back and 
forward 
buttons

Bus and Flow 
information

Click links to 
jump to new bus

Serial buses 
are shown 

automatically

Enter a name or number 
to go to a bus Click to find a bus
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Bus View Oneline

Right-click 
elements for 
information

Left-click 
circuit breaker 
to open/close

Colors are set by the Default Drawing 
Values

Symbols 
show 
locations of 
generators, 
loads, 
shunts

2 tiers are 
shown
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• Number of Tiers – specify 1 or 2
• Show Hints

– As you move your cursor over an object
it will show information 

• Show Serial Buses
– Buses that are in series will be cascaded

• Show Equivalent Lines
– Change to hide/show equivalent lines

• Represent Multi Section Line Objects
– Show endpoints of MS Lines without intermediate buses

• Open Multiple Bus views
– Specify whether to create a new Bus View when a new one is requested.
– Choosing Prompt means you will be prompted each time

• Include Field Labels
– A description of what each field is will be shown.

• Change Bus Link Color
– The fill color of the bus links can be changed

Bus View Oneline:
Click Options > to reveal



34© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

• Define Custom View
– Will discuss next

• Input Data – pre-defined view
– Shows information related to input parameters

• System State – pre-defined view
– Shows information about the system state

• If Custom Views are defined, they will appear 
at the bottom of this list

Bus View Oneline
Click Views > to reveal
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Input Data

Bus: CLINTON (32346)
Nom kV: 345.00
Area: IP (57)
Zone: IP (325)

Input Data

ID 1 ID 1 

R=
X=
G=
B=
LimA=
LimB=
LimC=

Number=
Nom kV=

 MAROA W  
CKT 1

 MAROA E  
CKT 1

 BROKAW2  
CKT 1

CLINTON  930.000 MW
   0.000 MW

   1.786 MW
   0.000 Mvar

0.00050 pu
0.00610 pu
0.00000 pu
0.10315 pu
1129.00 MVA
1297.00 MVA
0.00 MVA

32349
345.00 KV

0.00050 pu
0.00620 pu
0.00000 pu
0.10417 pu
1129.00 MVA
1297.00 MVA
0.00 MVA

32350
345.00 KV

0.00080 pu
0.01110 pu
0.00000 pu
0.19067 pu
1129.00 MVA
1297.00 MVA
0.00 MVA

32447
345.00 KV

System State

Bus: CLINTON (32346)
Nom kV: 345.00
Area: IP (57)
Zone: IP (325)

System State

ID 1 ID 1 

 MAROA W  

CKT 1

 MAROA E  
CKT 1

 BROKAW2  
CKT 1

CLINTON

1.0400 pu
358.80 KV
 -8.98 Deg
  0.00 $/MWh

 930.000 MW
 233.874 Mvar

   1.786 MW
   0.000 Mvar

 153.8 MW

  81.1 Mvar
 173.9 MVA

A

MVA

32349
1.0342 pu
356.80 KV

 276.6 MW

  79.8 Mvar
 287.9 MVA

A

MVA

32350
1.0337 pu
356.63 KV

 497.8 MW

  72.9 Mvar
 503.2 MVA

A

MVA

32447
1.0286 pu
354.88 KV

Bus Views:
Input Data and System State
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• Add custom fields 
to bus view 
oneline

• Select Views 
Define Custom 
View from bus 
view oneline

Custom Bus View

Add new object 
fields to certain 

positions
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Oneline Diagram Creation and 
Tools
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• Oneline diagrams enable easy visualization of power 
flow and other analysis results.

• A diagram need only be created for a desired subset 
of the system; Simulator always models the ENTIRE 
system in calculations.  

• Simulator will automatically link an open oneline to 
the existing power system model.

• A power flow case can be modified from diagrams or 
text-based Case Information Displays (more in the 
next section).

Building Onelines
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• Click the File Menu and choose New Oneline
• Simulator will switch to Edit Mode if not already
• Includes the ability to insert pre-defined

– U.S. state and county borders
– Canadian Province borders
– World Country borders

• Select Draw ribbon tab Auto Insert  Borders
– Select Options tab.  Adjust line color and thickness if 

desired.
– Choose TX – Texas from the PowerWorld Library 

United States tab
– Select the borders and map projection (under the 

respective tab).  Click OK.
– Repeat for Texas Counties

Building Onelines
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• Simulator supports three projections for representing 
earth in two-dimensional space
– Simple conic

• Suitable for North America only
• Latitude lines are curved; longitude lines are radial

– Mercator: Latitude lines are straight, form rectangles with 
longitude lines

– Alaska (Albers Conic): similar to simple conic, but longitude 
is centered on Alaska

• Once a projection is selected for a oneline, it should 
be used for all mapping and GIS functions so that 
objects are drawn in proper relation to one another

Map Projection
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Built-In Geographic Borders
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Built-In Geographic Borders:
With US Counties
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Built-In Geographic Borders:
Entire World
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• Zoom ribbon group under the Onelines ribbon tab
– Zoom in and out buttons
– Rectangular zoom selector
– Zoom percentage

• Mouse wheel zooming
– “Enable Mouse Wheel Zooming” checkbox on Simulator Options dialog, 

Oneline → VisualizaƟon page
• Zoom In

– Ctrl-Up Arrow key
– Ctrl-Page Up key zooms in quickly
– Ctrl-Alt and use left mouse button to select region on which to zoom in

• Zoom Out
– Ctrl-Down Arrow key
– Ctrl-Page Down key zooms out quickly
– Ctrl-Alt and use right mouse button to select region on which to zoom out

Zooming
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• Left-click and drag on empty space in the one-line
• Keyboard Shortcuts

– Pan Up
• Up Arrow key
• Page Up key pans quickly

– Pan Down
• Down Arrow key
• Page Down key pans quickly

– Pan Left
• Left Arrow key
• Home key pans quickly

– Pan Right
• Right Arrow key
• End key pans quickly

Panning
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• Zoom in, centered on Sterling 
County (OK if not exact)

• Select Draw Network 
Bus

• Click on the oneline
• Enter 3058 in Bus Number

– select Find by Number, if 
necessary, to view bus info

• Select OK to place the bus

Building Onelines
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• Repeat this procedure, entering buses 3059, 
3060, and 1020.

• Oneline should look similar to the following

Building Onelines

Left-click a bus and drag 
to relocate it. When 
“handles” are active, 
you can also click and 
drag an endpoint to 
stretch the length of 
the bus
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• Lines between buses can be inserted manually.
• It is easier to use automatic line insertion.
• Select Draw  Auto Insert  Lines

– Clear “Insert Text Fields” checkbox
– click OK
– lines joining buses are automatically added, 

optionally with circuit breakers and pie charts

Automatic Line Insertion
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Automatic Line Insertion

Clear “Insert Text 
Fields” for this example

Optionally set a 
minimum kV level of 

lines to be inserted

Options for branches 
with very low impedance

Optionally use only 
selected buses (available 

if a selection is active)
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• Loads can be inserted manually using Draw 
Network Load

• Easier to use automatic load insertion
• Select Draw  Auto Insert  Generators…

– Select default options
– Click OK to automatically add generators to 

displayed buses
• Automatic Load and Switched Shunt Insertion 

are also available, as is Lines, Gens, Loads, and 
Shunts in a single action

Automatic Load, Generator,
and Shunt Insertion
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Auto Insert Lines, Gens, Loads, and 
Shunts
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• To reposition a bus, left-click and hold the left 
mouse button, drag the bus to the desired 
location, and release the left mouse button.
– Note that all attached (and anchored) objects move 

with the bus.
– Individual objects such as generators and loads can 

be repositioned similarly.

• To reposition the entire oneline, click on the 
diagram (not on a specific object) and drag.

Moving Oneline Objects
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• Keyboard shortcuts
– Left-click on and select object(s) to move
– Shift-arrow keys (up, down, left, right) move in small steps
– Shift-Page Up moves object(s) up in larger steps
– Shift-Page Down moves object(s) down in larger steps
– Shift-Home moves object(s) left in larger steps
– Shift-End moves object(s) right in larger steps

Moving Oneline Objects
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• After selecting a line, 
handles appear at each 
vertex
– The cursor changes to a 

“cross-hair” symbol when 
moved over a handle.

– Click and drag to move the 
vertex

• To add a vertex, hold down 
the Ctrl key and left-click at 
the desired insertion point

• To delete a vertex, hold 
down the Ctrl key and left-
click on the vertex

Modifying Line Routing

Handles Appear
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• An invisible drawing grid helps align oneline 
objects.  By default, all objects snap to this grid.  

• Hold done the ALT key while moving an object 
to temporarily disable “snap-to-grid”.

• To enable/disable the grid:
– Select the Options ribbon tab  Oneline Display 

Options
– See Snap Objects to Grid section on the 

Grid/Highlight Unlinked page.
– Can change the spacing, display grid lines, etc.

Drawing Grid
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Display Grid Lines
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• Circuit breakers are used to indicate status of lines 
and transformers (not true breaker representation).

• Location of circuit breaker on the line does not matter.  
Typically one at each end, automatically inserted.

• To Insert, select Indication  Circuit Breaker, then 
click on desired location on transmission line.  Verify 
the Near Bus and Far Bus values are correct

Adding Circuit Breakers
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• Pie charts are usually automatically inserted.
– An exception: Equivalent lines or other lines with 

no MVA limits do not have a pie chart

• For manually inserting, select the Draw ribbon 
tab, Pies/Gauges  Line Flow Pie Chart. Then 
click on the line midpoint.  

• The pie charts are used to graphically indicate 
the percentage loading of each line.

Inserting Pie Charts
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• Accidental edits on oneline diagram can be undone
• Found on Draw ribbon tab (or use Ctrl+Z)
• Does not work with Case Information Displays
• Does not affect changes to power flow case (e.g. 

Deleting Object(s) and Record(s))

Undo Oneline Actions
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• Oneline actions are stored in system memory
• Memory limit for undo action can be adjusted in the 

Options ribbon tab Simulator Options
Environment page

Undo Oneline Actions

Memory limit



61© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

• Used with branches whose 
end points are not visible

• Small arrows appear where 
the branch exits the 
present window

• Clicking on arrow will pan 
to the other end of the 
branch

• Options for using 
navigation arrows found at 
Simulator Options 
Oneline Line Navigation 
Arrows

Line Navigation Arrows

How fast to pan

Set to 0 to disable

Show hints about other end 
of the line
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• Select Draw  Palette For  Buses
• select a displayed bus to see its displayed and 

undisplayed neighbors

Bus Palette

Select a displayed bus;
see displayed and
undisplayed neighbors

Insert undisplayed
buses by dragging 
from the palette to 
the oneline
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• Add buses 3111 and 3042
– select STERLING C~2 115 bus (3059), drag 

STERLING C~7 115 bus (3111) over bus 3059
– select STERLING C~7 115 bus (3111) , drag SILVER 1 

115 bus (3042) to oneline over bus 3111

• Lines and Loads are auto inserted by default

Bus Palette

Default can be 
changed by clicking 
options
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• Move your cursor over one of the generator 
objects on the oneline diagram.

• Press F1 key.
• This will bring up the online help for Simulator and 

take you to the help regarding that particular 
object

• Try this for loads, lines, etc…
• This will also work for

– Object Dialogs
– Case information displays
– and everywhere throughout Simulator

Simulator Online Help Files:
Context Sensitive
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• Oneline diagrams can also be used as case editors to add or 
remove power system objects

• Example: add a new
generator at Big Spring
– Switch to Edit Mode
– Choose Draw → Network 

→ Bus
– Click on the diagram near Big

Spring
– Simulator suggests a new 

bus number, 8161
– Give it a name, e.g. 

“Big Spring Wind Farm”
– Set Nominal Voltage to 34.5 kV

Add a New Bus
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• Choose Draw → Network → Generator
• Click on the new bus
• Enter parameters

– MW setpoint
– MW limits
– Mvar limts
– Fuel and Unit Type

• On Display Information
tab, optionally change 
Orientation to “Up”

Add a Generator
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• Choose Draw Network  Transformer.
• Click on the new bus. This begins process of inserting 

the transformer.
– Branches are drawn as a series of line segments
– Optionally move cursor to desired location, then left-click to 

enter a segment. (Sometimes useful for lines, but 
transformers often look better without intermediate 
segments)

– Double-click on Big Spring~1 bus to terminate.
• Note: Clicking and dragging mouse when drawing 

transmission lines is usually NOT recommended. This 
will produce a curved line with many segments.

Add a Transformer
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• Enter 
parameters

– X = 0.08
– R = 0.003
– Limit A = 

300

Add a Transformer
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• Save favorite settings 
of oneline location, 
zoom levels, and 
other parameters
– right-click, 

save/edit/delete view, 
or toolbar button

– identified by a 
specified name

– accept current 
settings, or specify 
your own

• Example: Save 
Current View as 
“Sterling City”

Saving Views
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• To view the entire oneline, click the Show 
Full button on toolbar.

• Zooming level and screen center is 
immediately changed so all objects on the 
oneline are visible.

• Can return to “Sterling City” View from 
Onelines → Save View → Sterling City

Showing Entire One-line
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• Buses and substations may also be auto-
inserted if geographic coordinates are available

• PowerWorld Simulator’s pwb format has long 
supported geographic coordinates for buses, 
substations, and other basic network elements

• EPC file format has recently added geographic 
support – most WECC cases have at least 
partial geographic coverage

Auto-Inserting Buses
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• Choose Draw  Auto 
Insert  Buses…

• Select “Longitude and 
Latitude stored with 
substation records”

• Make sure you use the 
same map projection the 
rest of the diagram uses

• Select “Auto insert 
transmission lines when 
finished”

• Choose OK, Perform Auto 
Insertion

Auto-Inserting Buses
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• From here, if we wish, 
we can edit the Default 
Drawing Values (also 
available from the Draw 
and Options Ribbons)

• Click the button to open 
Default Drawing Values

Automatic Insertion of Transmission 
Lines
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• Changes made here affect only FUTURE oneline 
display object insertions, not EXISTING objects.

• Click the Field Positions tab choose how fields 
are automatically inserted around an object.

• Position columns appear in grid.  Double-click a 
position field to choose the type of field to 
display, or use the Field Positions diagram to 
set displayed fields.

Drawing Defaults: Formatting FUTURE 
Oneline Display Objects
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Color Coding and Drawing Values

Object default drawing 
values for kV range

kV Range 
and Color

Field Positions tab sets text fields automatically inserted (next slide)

Set a default font size for 
all new text fields
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• For example, to clear all fields from Display Transmission Line/Display 
Transformer
– Click on a field, then choose Remove Field on dialog
– On confirmation for showing field for all voltage levels, choose Yes

Auto Field Insertion
Click the Field Positions Tab

Object Type of 
fields being 

modified

Click on Positions 
to Add, Change, 
or Remove Field 

Type Displayed
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• Close the Default 
Drawing Values and 
complete the Automatic 
Insertion of 
Transmission Lines

Full Oneline with Auto-Insertion



78© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

• Cases are normally saved in PowerWorld Binary 
(pwb) format

• Onelines are saved in separate files (pwd), 
which enables them to be used across cases

• A single case may also have multiple associated 
onelines (e.g. one with buses, lines, and 
transformers, another with substations and 
lines only, and another with areas and 
interfaces)

Saving Cases and Onelines
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• Save the case with File → Save Case As…
– Use the pwb format
– Give it a unique name, such as 

ACTIVSg2000BigSpringWind.pwb
• Simulator will ask if you want to change the name of the 

oneline. Choose Yes.
• The oneline may or may not save when the case is 

saved.
– Check the log to see if it saved.
– This is a user option in Simulator 

OpƟons → Oneline → File.
• To save the oneline explicitly, choose File → Save 

Oneline

Saving Cases and Onelines
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• On large onelines, sometimes it is time 
consuming to find a particular bus.  Rather, you 
can use the Find Object on Oneline option 
from the local-menu.

• This displays the Zoom, Pan and Find Objects 
dialog. 

Finding Buses on Onelines
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• To find a particular bus
– set Object Type to Buses
– use advanced search engine to locate the desired 

bus by number or name
– select Pan to Object on Oneline to center the 

oneline on the specified bus

• Find does not change the current zoom level, 
unless Auto-Zoom when Panning is checked.

Finding Buses on Onelines
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• Go to Run Mode and 
select Tools  Play.

• Can interact with the 
oneline such as opening 
a circuit breaker; note 
how flows redistribute

• For example, return to 
Sterling City view and 
open transformer 
between Sterling C~1 
and Sterling C~2

Simulating the Case (Play Mode)
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• Pause the Simulation 
(next to the Play button)

• To view/modify parameters for any oneline 
object, right-click on the object and show its 
information dialog (specific text varies by 
object type). 

• Many of these parameters can be modified, 
with the results taken into account when the 
simulation is resumed.

Run-time Object Dialogs
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• Default Drawing Values allow you to change 
the default appearance of FUTURE display 
objects

• To move, remove, or change formatting of 
EXISTING display objects, make use of the 
following to features:
– Selecting Multiple Objects
– Formatting of Selected Objects

Formatting EXISTING Oneline Display 
Objects
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• Multiple oneline objects can be selected by different 
mechanisms:
– Individually by left-clicking on objects while holding down Shift 

key
– Using the Select buttons to select all objects in a region, available 

in the Select ribbon group under the Draw ribbon tab. 
• Hold Shift-Ctrl and drag with the left mouse button to select area that 

encompasses desired objects
• Hold Shift-Ctrl and drag with the right mouse button to select area that 

encompasses desired objects and to retain currently selected objects
– Using Select by Criteria, available in the Select ribbon group 

under the Draw ribbon tab
• Suppose we wish to change the color of all 500 kV lines.

Selecting Multiple Objects
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• On the Draw
Ribbon, 
choose Select 
by Criteria

• Select “Display 
Transmission 
Line”

• Select a 
Voltage Range 
between 400 
and 599

Select by Criteria Dialog

Objects can 
either be
selected for 
entire case,
or by specific 
areas/zones/ 
layers
and by 
voltage level

Criteria sets 
may be saved 
for easy re-
use.



87© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

• Right-click on any line 
that is already selected 
to bring up the local 
menu and choose 
Format Selection…

• Could also use the 
Format option from the 
Draw Ribbon

• On the Line/Fill tab, 
change Line Color

Changing the Format: Line/Fill

Line 
Information

Color 2, used with 
transformers (i.e.
for different 
voltage levels)
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• Ability to resize and rotate oneline objects 
easily with your mouse.

Oneline Diagram Enhancements:
Resize/Rotate Objects

Green Circle:
Rotation Point

Black Square:
Resize Handle

Gray Square:
For looks only
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• Add oneline objects to layers for customized views. 
Select the Onelines ribbon tab  Layers Define 
Layers to create or modify screen layers

• Assign objects to layers using the Levels/Layers button 
on the Formatting ribbon group on the Draw ribbon tab

Screen Layers
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• Borders are normally added 
to a Screen Layer called 
“Borders” (option for this
during auto-insertion)

• View the existing Layers 
from the dropdown

• Check or de-check Layer Name to show or hide the 
layer

• Example: move all Generator, Load, and Shunt 
Objects to a new Layer (tip: use Select by Criteria)

Screen Layers
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Format Selected Object:
Level/Layers

Set these values to force a 
display object to not move or 

resize

Change Stack Level

Screen Layers 

Fonts and Pie Charts can be set 
so that they only resize 

between particular zoom levels
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• Objects are shown on oneline using four different 
stack levels, base, background, middle and top.  

• By default, different types of objects can have 
different levels.  For example, transmission lines are 
level middle, while circuit breakers are level top.

• Stack level can be changed by first selecting an object, 
then using the Levels/Layers button on the 
Formatting ribbon group under the Draw ribbon tab.

Object Oneline Display Levels
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• What is shown on top is first governed by the 
stack level

• Objects within the same stack level can be 
moved relative to one another. Go to the Draw
ribbon tab and choose the Bring to Front or 
Send to Back buttons from the Formatting
ribbon group.

Bring To Front / Send To Back
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Format Selected Object:
Display/Size

Size of an 
object can be 

changed

Setting an object as immobile 
will prevent you from moving 
the object by dragging it with 

the mouse.

Objects such as generators have 
an orientation which may be 

changed
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Format Selected Object:
Font

Font 
Properties

Color and 
Rotation 
Angle



96© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

Format Selected Object:
Field

Field 
Information

Change how the 
field looks: digits, 

decimal and suffix
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• If you change the Default 
Drawing Values, and then 
wish to apply them to 
EXISTING objects
– Select one or more objects
– Right-click on a selected 

object to bring up the local 
menu and choose Apply 
Default Draw Values…

– Select All and choose OK

Changing to Match Default Draw 
Values
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• After lines have already 
been inserted, stub 
locations can be redone
– Reopen Default Drawing 

Values
– Change the Stub Size and 

Stub Spacing for Display 
Transmission Line… for 
appropriate Nom kV 
level(s)

– Choose Auto Insert > 
Reset Stub Locations… 
and OK

Reset Stub Locations
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• Selecting an 
object type with 
an arrow opens 
a pane with 
specific options.

• Example: 
Transmission 
Line Fields.

Select by Criteria:
Choosing specific fields

Click OK to select all objects meeting the criteria.
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• Choose the Tabs and 
check what you want

Choose specific Areas, Zones, or 
Screen Layers
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• Click on the type of object you’re interested in and click 
Add/Modify Filter… (or just double-click on the Filter 
column)

Use Advanced Filtering in Conjunction 
with Select By Criteria

Double-click

Dialog appears
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• Select a group of oneline objects and then click 
the button Copy Format
– This will copy all the attributes that are the same 

across the selected objects
• For example: If all objects have a fill color (suppose they 

are RED), then it will copy this.  But if some objects are 
RED while others are BLUE, it will not copy this attribute.

Applying the format of one object to 
another: Copy Format
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• After you have chosen to Copy Format, then the Paste 
Format button will be enabled.

• Now select another group of objects to apply the 
copied formatting to and click the Paste Format 
button
– Only attributes that were 

the same across the copied 
selection will be enabled.

– Check the attributes you 
would like to paste and 
click OK

Paste Format



104© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

• If you press the Delete key (or choose Delete from the Draw Ribbon) 
with one or more oneline objects selected, Simulator gives the 
options:
– Delete Object(s) Only: remove the oneline object, but do not change 

the system model
– Always Delete Object(s) Only: also sets an option so the confirmation 

dialog will no longer display (can reverse this in Default Drawing Values)
– Delete Object(s) and Record(s): also removes the object from the 

power system model
• Example

– delete the Big Spring shunt, 
object only

– It is removed from the 
oneline, but still present in 
Case Information 
Display and Bus View Oneline

Deleting Objects
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• Fields can be entered automatically (Default 
Drawing Values) or manually by
– choosing Field and then a specific type from the Draw

ribbon tab.
– Making a selection on the diagram, then right-clicking 

for the local menu, then Add New Fields Around 
Selection…

• Bus fields show information about bus devices, 
including loads and generators.
– Can choose type of field, digits to right and left of 

decimal, and whether or not it is anchored.
– Example: Add “Bus Voltage (p.u.)” at Big Spring

Bus Fields
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• Line fields show information about 
transmission lines and transformers.

• For line fields, flow is always specified at an 
end of the transmission line or transformer.

• End is normally determined automatically by 
insertion point.

• Fields are available for many other types of 
power system objects (generators, loads, DC 
lines, and many more)

Line Fields
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• Right-clicking on an empty portion of the 
oneline displays its local menu.  The local menu 
is used to 
– Print the oneline
– Save entire screen to file as a bitmap
– Copy/save oneline in Windows metafile format, 

which is more versatile than a bitmap
– Open Display Explorer

Oneline Local Menu
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– Find objects on the oneline
– Pan/Zoom Control
– Show Oneline Display Options; this display is used 

to customize the appearance of the oneline
– Edit screen layers and show layers
– Perform contouring (covered in a later section)

Oneline Local Menu
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– View difference flows (covered in a later section)
– Toggle flow visualization; switch between 

displaying actual flows and PTDF flows (covered in 
a later section)

– Save/edit/delete view
– Go to view

Oneline Local Menu
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Oneline Display Options:
Display Options Page

Another Slide 
explains

Flow fields specify a 
near and far bus.  
This implies a 
direction, so a 
negative sign is 
normally displayed 
for flows in the 
opposite direction. 
Check this box to 
NOT show the 
negative sign.

Covered in 
later section

Options for 
visualizing out-of-
service elements
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Display Object Options:
General Options

Only affects Bus 
Voltage Fields

Each time the 
display refreshes, 
the generators 
“rotor” will rotate 
this amount

Change appearance 
of MS Line 
intermediate buses, 
relative to end 
buses

Show 
selected 
field inside 
generator

Choose 
where to 
show circuit 
breakers

1 2

One

 102 MW   50 MW
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Display Object Options:
Circuit Breakers

Choose outline 
and fill color for 
normally open 
and normally 
closed circuit
breakers

Choose the 
circuit breaker 
shape
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Display Options Tab:
Set Custom Detail

• Display Detail
– Complete: show 

everything
– Moderate: remove pie 

charts and line fields
– Minimal: remove pie 

charts and all fields except 
those associated with 
generators, loads, or 
shunts

– Custom Detail: opens the 
Select by Criteria dialog 
(pictured) to specify a 
custom display detail by 
area, zone, layer, and 
other criteria
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Oneline Display Options:
Pie Charts/Gauges Page

Pie chart 
percentag
e based on

When values are 
higher than this 
percent, the 
number will 
appear inside the 
pie chart

Line flows are 
different at each 
end of the line, this 
specifies to always 
using Limiting Flow
Limiting Flow is normally the 
higher value, but this can be 
changed in the Limit 
Monitoring Settings Specifies the colors 

and scales of pie 
charts when values 
are higher than the 
percentage 
breakpoint.

Gauge value 
based on

Display 
percentages in 
gauge instead of 
unit values

Separate 
options for lines 
and interfaces

Default styles for Generator, 
LTC, and Shunt and user 
defined styles (Used with pie 
chart/gauges other than lines and interfaces)
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Oneline Display Options:
Pie Charts/Gauges Page, Lines Tab

Sub-tabs allow separate 
breakpoints for different 
measurement types

Uses same settings as MVA 
measurements, so fields are 
grayed out

Special formatting options for 
open lines
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Oneline Display Options:
Pie Charts Page, General Options Tab

Show current limit 
set (selected in limit 
monitoring settings)

Show what is 
being measured

Highest zoom 
level for resizing

Minimum font 
size in the pie 
chart

Internal pie chart 
background fill

Text font size 
relative to pie 
chart size

These options only 
apply to Line and 
Interface pie 
chart/gauges
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Pie Charts Options Ribbon
Click Options  Pie 
Chart to reveal

Same Setting
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Background and Pie Chart Color 
Example

 50%

 68%

 79%

Background Color for 
Oneline = Yellow

Pie Chart Background 
Color = White

Warning Percent = 60
Warning Color = Orange
Warning Scalar = 1.5

Limit Percent = 70
Limit Color = Red
Limit Scalar = 2.0

Show Value Percent = 45
Normal Color = Blue
Normal Scalar = 1.0



119© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

Oneline Display Options:
Animated Flows Page

Show Animated Flows

Density and Size 
of Arrows

Symbol used 
to show flows-
almost always 
use Arrows

Click this button 
to initialize the 
arrows to 
reasonable 
numbers.

Select Objects

Make 
Arrows move Flows are based 

on these values.

Parameters 
used when 
Animating 
Size.  See the 
next slide for 
more info.

Change to make 
flows move faster
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• Arrow Size
– Arrow Size when NOT Animating Size

– Arrow Size when Animating Size
• Actual Flow 

– Actual flows higher than 2 times the FlowReference will not appear larger than a flow 2 
times the FlowReference

• Percent Flow
• Arrow Spacing

How do these parameters affect the 
Arrow Size and Spacing

Size~ArrowArea









nceFlowRefere
entFlowOnElem*Size~ArrowArea

wcentageFloElementPer*Size~ArrowArea

Density
1~ngArrowSpaci

Click the button Automatically Set Size, Density, and Parameters for this 
oneline to get values that look reasonable for your oneline
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Example Variable Flow Size

 59 MW

 58 MW

 43 MW  41 MW

 32 MW  32 MW

 38 MW

 37 MW

 79 MW  76 MW

 31 MW

32 MW

 14 MW

 39 MW

 40 MW 20 MW 20 MW

 40 MW

 40 MW

 20 MW  20 MW

 14 MW
 40 MW

110 MW
 80 MW

130 MW
200 MW

200 MW

170 MW

200 MW 201 MW

 95 MW

102 MW

Animate Size = TRUE
Reference Size = 200 MVA
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Animated Flow Options Ribbon
• Notice that all the settings on the dialog are available

Same Setting

Click Options 
Animation to reveal
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• Use to show an overview window for the oneline

Oneline Display Options:
Thumbnail View Page
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Thumbnail Example

  34 MW
  12 MVR

  14 MW
   6 MVR

  24 MW
   5 MVR

  59 MW
  23 MVR

  19 MW
   9 MVR

  37 MW
  24 MVR

  28 MW
  17 MVR

  37 MW
  13 MVR

  52 MW
  26 MVR

  17 MW
   6 MVR

  80 MW
  32 MVR

   8 MW
   1 MVR

  73 MW
  47 MVR

  22 MW
  12 MVR

  23 MW
   5 MVR

  90 MW
  38 MVR

  47 MW
  23 MVR

  76 MW
  30 MVR

  30 MW
  13 MVR

  85 MW
  47 MVR

  70 MW
  38 MVR

  97 MW
  56 MVR

  93 MW
  46 MVR

  68 MW
  33 MVR

  60 MW
  31 MVR

  44 MW
  10 MVR

 167 MW
  69 MVR

 137 MW
  32 MVR

 127 MW
  45 MVR

   5 MW
   2 MVR

  34 MW
   9 MVR

  41 MW
  18 MVR

  44 MW
  12 MVR

  16 MW
   7 MVR

  27 MW
   9 MVR

  26 MW
  17 MVR

  21 MW
   7 MVR

  41 MW
  12 MVR

  39 MW
  24 MVR

  55 MW
  31 MVR

  72 MW
  25 MVR

  26 MW
  12 MVR

  52 MW
  19 MVR

  27 MW
   9 MVR

  22 MW
   9 MVR

  26 MW
   5 MVR

  20 MW
   5 MVR

  16 MW
   7 MVR

  19 MW
   9 MVR

  44 MW
  12 MVR

  38 MW
  16 MVR

  16 MW
   8 MVR

  15 MW
  13 MVR

   9 MW
   0 MVR

  15 MW
   7 MVR

  32 MW
  12 MVR

  28 MW
  11 MVR

  36 MW
  21 MVR

  17 MW
   6 MVR

  38 MW
  14 MVR

  59 MW
  15 MVR

  57 MW
  16 MVR

  52 MW
  16 MVR

  55 MW
  11 MVR

  37 MW
  13 MVR

  50 MW
  23 MVR

  39 MW
   8 MVR

  51 MW
  23 MVR

   1 MW
   1 MVR

  30 MW
  12 MVR

  27 MW
  14 MVR

  22 MW
   8 MVR

  50 MW
  11 MVR

  10 MW
   5 MVR

  49 MW
   9 MVR

  65 MW
  26 MVR

  39 MW
  13 MVR

  25 MW
  10 MVR

  48 MW
  19 MVR

  30 MW
  14 MVR

  30 MW
  12 MVR

  30 MW
  11 MVR

  37 MW
   9 MVR

  51 MW
  19 MVR

   3 MW
   2 MVR

  55 MW
  23 MVR

  45 MW
  15 MVR

  51 MW
  22 MVR   34 MW

  14 MVR

  16 MW
   3 MVR

  48 MW
  13 MVR

   6 MW
   3 MVR

  22 MW
   7 MVR

  12 MW
   5 MVR

  19 MW
   5 MVR

  12 MW
   4 MVR

  72 MW
  28 MVR

  32 MW
  10 MVR

  22 MW
   7 MVR
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Thumbnail View Options Toolbar
• Right Click in the toolbar region and Choose the ThumbNail View Options Toolbar to 

make it visible if needed
• Notice that all the settings on the dialog are available

Same Setting

Click Options 
 Thumb 
Nail to reveal
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• Descriptive text fields, unlinked to specific power 
system objects, can be added to the oneline by 
selecting Background  Text or Memo Text from the 
Draw ribbon tab.

• To change font and background color of text fields:
– Select the text field
– Select the Format button

Text Fields
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• Create a link to another oneline by selecting 
the Draw ribbon tab, Background button 
Oneline Link
– Clicking on this word will open up the other oneline

• Any file can be linked and its associated 
application will automatically open.  
– This means that power point files or word 

documents or spreadsheets can all be linked

Oneline and Document Links
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• To show static background line on the one-line, select 
Draw  Background  Background Line
– click to start the background line and to add segments.
– double click to end

• Use Draw  Format to edit
appearance.  
For this example, 
apply blue 
fill for a lake.

Adding Background
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Sterling City Oneline
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• To include pictures, such as bitmaps, JPEGs, or 
metafiles, on the oneline, select the Draw ribbon tab, 
Background button Picture.
– Use Open Picture Dialog to find desired picture
– Dialog provides a preview window

• You can also use the Window’s Clipboard to copy 
objects from other programs, such as a graph from a 
spreadsheet or image from web.

Adding Pictures to the Oneline
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Example: Company Logos
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Using An Existing Oneline with 
a New Power System Case



133© 2023 PowerWorld CorporationI1: Case Editor and One-line Diagrams

• You’ve created a detailed oneline of your system and 
it matches your current case

• A new power system case is issued a year later, but 
topology differences mean the original oneline no 
longer matches perfectly
– System elements are reconfigured
– Bus numberings change
– More detail or less detail in the case

Situation
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• Open the new power system case
• Choose Open Oneline from the File Menu to open 

your old oneline
• Now, find out if all the elements on the oneline are 

still linked up with the case
• Choose Onelines  List Display  Unlinked Display 

Objects
– This gives you a list of display objects that have no 

corresponding data in the case

Integrating an old Oneline with a new 
Case
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• “Few” may mean less than 500
– If Bus 101 were removed in case at 

right there would be 17 unlinked 
objects created by this!

• If only have a few, easiest process 
is to
– Delete unlinked all objects
– Fix up the areas on the oneline 

affected

Fixing a Few Unlinked Oneline Objects

Bus 101

Bus 102

Bus 103

1.03 pu

700.00 MWMW

0.99 pu

404.0 MW -81.3 MVR

160.6 MW 5.3 MVR
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• When saving a diagram (*.pwd) file, Simulator 
automatically includes a table inside this file which stores 
data necessary to do the renumbering routine

• Can renumber based on Name_KV or Label linking
• This allows you to perform the renumbering automatically 

when you open the diagram
– Choose Open Oneline from the File Menu
– Change Files of type to Oneline Display File (Name_KV linking) or 

Oneline Display File (Label linking)
– Choose the file to open

• This automatically renumbers the diagram
– BE CAREFUL.  If the case does not have unique “name-nominal 

kV” values this can cause incorrect linking.
– All objects should have labels defined for label linking to work 

Integrated Bus Renumbering
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• If you have a lot of unlinked objects, then the 
case bus numberings have probably changed

• Best option is to attempt to “renumber” the 
buses on the oneline

Fixed A Lot of Unlinked Objects:
Bus Renumbering
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• Open the old oneline with the OLD CASE
• In Edit Mode, choose Tools  Renumber 

Renumber Buses
• Select Load Only Buses on Oneline and press the 

Setup Bus Swap List button
• Right Click on the table and choose Save  As 

Auxiliary File…
– Select a name such as (oldscheme.aux)

• Close Renumber Buses dialog

Bus Renumbering
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• Open the NEW CASE and the old oneline
• Choose Tools  Renumber  Renumber Buses
• Select Freshen Current Oneline and specify the file 

you saved (oldscheme.aux)
• Click the Setup Swap List Button

– Simulator will match the old numbering scheme used in the 
oneline with elements in the new case by BUS NAME and 
KV.  

– Tie breakers will use the BUS AREA NAME
– If it still can’t figure it out, it puts in both options

Bus Renumbering (cont)
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• Go through the new list and make sure you 
want to swap as they are listed

• Change the Swap? field for those you want to 
switch

• When you’ve selected what you want to swap, 
click Change Bus Numbers at the bottom of the 
form

• NOTE: It will take a long time to renumber a big 
oneline

Bus Renumbering (cont)
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• Our affiliate, Energy Visuals, provides 
geographic-based one-line diagrams as a 
subscription service
– Updated annually
– Let them worry about bus renumbering!

• +1 (217) 398-8035, Tim Born
• http://www.energyvisuals.com
• Energy Visuals also provides generator cost 

models for use with Optimal Power Flow (OPF)

One-line Diagrams for FERC 715
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